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Chapter 703

Equivalence Tests for
the Difference of Two
Hazard Rates Assuming
an Exponential Model
Introduction
A clinical trial is can be employed to test the clinical equivalence of a treatment and a control in regards to the
survival distributions. The two-sample t-test is not appropriate for two reasons. First, the data are not normally
distributed. Second, some survival times are censored. For these reasons, special test statistics such as the logrank
test have been developed. This module computes the sample size and power for an equivalence test similar to the
logrank test, assuming survival times follow exponential distributions. Accrual time and follow-up time are
included among the input parameters.
This procedure is based on the unconditional method of Chow, Shao, and Wang (2008) which, in turn, is based on
the conditional methods of Lachin and Foulkes (1986). The conditional procedure does not extend to this case
(see Chow et al. page 173).

Technical Details
This section presents the unconditional clinical superiority method of Chow, Shao, and Wang (2008).

Basic Model
Suppose a clinical trial consists of two independent groups labeled “1” and “2” (where group 1 is the control
group and group 2 is the treatment group). The total sample size is N and the sizes of the two groups are N 1 and

N 2 . Usually, you would plan to have N1 = N 2 .

Equivalence Hypothesis
The equivalence of two hazard rates is established by concluding the difference between the hazard rates is less
than a small margin Δ. The statistical hypotheses that yields this conclusion when the null hypothesis is rejected is

H 0 : h2 − h1 ≥ ∆ versus H a : h2 − h1 < ∆
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Test Statistic
The power and sample size formulas presented below are for the difference of two exponential hazard rates. It is
anticipated that the actual test statistic is the regression coefficient from a Cox regression.

Test Comparing Hazard Rates
The original test statistic is the difference of the hazard rates estimated by maximum likelihood divided by their
standard error. The maximum likelihood estimate of an exponential hazard rate for a particular group is

hˆ =

number of events
sum of study time of all subjects

Chow, Shao, and Wang (2008) indicate that the test statistics
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can be used to test the hypothesis of equivalence.
Specifically, the null hypothesis of non-equivalence is rejected if

Z1 < − z1−α

and

Z 2 > z1−α

Power Calculations
Assuming an exponential model with hazard rates h1 and h2 for the two groups, Chow et al. (2008) give the
following equation for the power of the above equivalence test.
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where

σ 2 (hi , ωi , A) =

hi2
E (d i | hi , ωi , A)
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These parameters are interpreted as follows.
Parameter

Interpretation

σ 2 (h, ω, A)

Variance of ĥ

E (d i hi , ωi , A)

Expected proportion of events (deaths) in group i

di

Indicates the a person does (d i = 1) or does not (d i = 0 ) die in group i

hi

Hazard rate of group i (see below)

ωi

Loss to follow-up hazard rate of group i (see below)

A

Patient entry parameter (see below)

R

Accrual time

T

Total time

T −R

Follow-up time

Exponential Distribution
The hazard rate from the exponential distribution, h , is usually estimated using maximum likelihood techniques.
In the planning stages, you have to obtain an estimate of this parameter. To see how to accomplish this, let’s
briefly review the exponential distribution. The density function of the exponential is defined as

f (t ) = h exp{ − h t}, t ≥ 0, h > 0.
The cumulative survival distribution function is

S (t ) = exp{ − ht} , t ≥ 0.
Solving this for h yields

h=-

log{ S (t )}
t

Note that S(t) gives the probability of surviving t years. To obtain a planning estimate of h , you need only know
the proportion surviving during a particular time period. You can then use the above equation to calculate h .
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Patient Entry
Patients are enrolled during the accrual period. PASS lets you specify the pattern in which subjects are enrolled.
Suppose patient entry times are distributed as g(t) where ti is the entry time of the ith individual and 0 ≤ ti ≤ R.
Let g(t) follow the truncated exponential distribution with parameter A, which has the density

 A exp{− At}
if 0 ≤ t ≤ R, A ≠ 0

g (t ) = 1 - A exp{− AR}

1
otherwise
where
R is accrual time.

A is interpreted as follows:

A > 0 results in a convex (faster than expected) entry distribution.
A < 0 results in a concave (slower than expected) entry distribution.
A = 0 results in the uniform entry distribution in which g(t) =1/R.
Rather than specify A directly, PASS has you enter the percentage of the accrual time that will be needed to enroll
50% of the subjects. Using an iterative search, the value of A corresponding to this percentage is calculated and
used in the calculations.

Losses to Follow-Up
The staggered patient entry over the accrual period results in censoring times ranging from T - R to T years during
the follow-up period. This is often referred to as administrative censoring, since it is caused by the conclusion of
the study rather than by some random factor working on an individual. To model the losses to follow-up in each
group which come from other causes, we use the exponential distribution again, this time with hazard rates ω1

and ω2 . You can obtain appropriate loss-to-follow-up hazard rates using the following formula or by using the
Survival Parameter Conversion Tool available from the Tools menu or by pressing the small button to the rate of
the loss-to-follow-up hazard rate box.

ω=-

log{1 − Ploss (R )}
R
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. The parameters that may be
selected are Power or Sample Size. Select Sample Size when you want to calculate the sample size needed to
achieve a given power and alpha level. Select Power when you want to calculate the power.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
equal survival curves when in fact the curves are different.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when you
reject the null hypothesis of inferiority when in fact the treatment group is non-inferior.
Values of alpha must be between zero and one. Since this is a one-sided test, it is common for people to use 0.025
rather than 0.05 for alpha.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size (When Solving for Sample Size)
Group Allocation
Select the option that describes the constraints on N1 or N2 or both.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both
sample sizes at once, no additional sample size parameters need to be entered.

•

Enter R = N2/N1, solve for N1 and N2
For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2,
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
N2 = R * N1.
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•

Enter percentage in Group 1, solve for N1 and N2
For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS
determines the needed N1 and N2 with this percentage to obtain the desired power.

R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”
R is the ratio of N2 to N1. That is,
R = N2 / N1.
Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this
ratio are considered.
N2 is related to N1 by the formula:
N2 = [R × N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1 (e.g., N1 =
10 and N2 = 20, or N1 = 50 and N2 = 100).
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”
Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2.
Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

Sample Size (When Not Solving for Sample Size)
Group Allocation
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. A single per group sample
size will be entered.

•

Enter N1 and N2 individually
This choice permits you to enter different values for N1 and N2.

•

Enter N1 and R, where N2 = R * N1
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

•

Enter total sample size and percentage in Group 1
Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N,
and then N2 as N - N1.
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Sample Size Per Group
This option is displayed only if Group Allocation = “Equal (N1 = N2).”
The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2
populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value
for N2.
The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values.
N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 =
R * N1.”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.”
R is the ratio of N2 to N1. That is,
R = N2/N1
Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:
N2=[R x N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1.
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single value or a series of values.
Total Sample Size (N)
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of
the total sample size in Group 1, implicitly defines N1 and N2.
The total sample size must be greater than one, but practically, must be greater than 3, since each group sample
size needs to be at least 2.
You can enter a single value or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of
values.
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Sample Size – Loss Hazard Rates
ω1 (Loss Hazard Rate of Control Group)
This is the lost to follow-up rates in group 1, the control group. This rate assumes that lost to follow-up follows an
exponential distribution. This value is the reciprocal of the average number lost to follow-up per unit of time
(months, years, etc.).
If all you have is the proportion lost to follow-up, use the Survival Parameter Conversion Tool to convert this
proportion into a hazard rate.
Any non-negative value is valid. Zero is used to indicate no loss to follow-up.
ω2 (Loss Hazard Rate of Treatment Group)
This is the lost to follow-up rates in group 2, the treatment group. This rate assumes that lost to follow-up follows
an exponential distribution. This value is the reciprocal of the average number lost to follow-up per unit of time
(months, years, etc.).
If all you have is the proportion lost to follow-up, use the Survival Parameter Conversion Tool to convert this
proportion into a hazard rate.
Any non-negative value is valid. Zero is used to indicate no loss to follow-up.
Equal to ω1
Enter ‘ω1’ if you want ω2 = ω1.

Sample Size – Duration
R (Accrual, or Recruitment, Time)
The accrual (or recruitment) time is the length of time during which patients enter the study. It is the value of R.
Percent of R Until 50% are Accrued
This option controls the pattern of patient entry by specifying the percentage of the accrual time needed to enroll
50% of the patients. PASS assumes that patient entry times follow the truncated exponential distribution. This
parameter controls the shape and scale of that distribution. The cumulative truncated exponential distribution is
given by the equation:
G(T|A)=A exp(-AT)/[1-exp(-AR)].
When G(T|A) is 50% and R and T are known, this equation may be solved for A.
Range
Values between 1 and 97 may be entered.
Recommended
If you expect uniform patient entry, enter 50. Unless you know that patient enrollment will not be uniform during
the accrual period, you should enter 50.
If you expect more patients to enter during the early part of the accrual period, enter an amount less than 50 such
as 30. A 30 here means that 50% of the patients will have been enrolled when 30% of the accrual time has
elapsed.
If you expect more patients to enter during the latter part of the accrual period, enter an amount greater than 50
such as 70. A 70 here means that 50% of the patients will have been enrolled when 70% of the accrual time has
elapsed.
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T-R (Follow-Up Time)
The follow-up time is the length of time between the entry of the last individual into the study and the end of the
study. Since T is the total length of the study and R is the accrual time, the follow-up time is T-R.

Hazard Ratios
h1 (Hazard Rate of Control Group)
Enter one or more hazard rates (instantaneous failure rates) for the control group. The exponential survival
distribution used in this procedure assumes that the hazard rates are constant throughout the whole experiment
and that this hazard rate is equal to one over the mean number of events per unit of time.
An estimate of the hazard rate may be obtained from the median survival time or from the proportion surviving
past a certain time point by pressing the Survival Parameter Conversion Tool button.
Range
A value greater than zero.
Examples
The following examples assume an exponential survival distribution.
Median Survival Time
0.5
1.0
2.0
3.0
4.0
5.0

Hazard Rate
1.386
0.693
0.347
0.231
0.173
0.139

Specify Hazard Parameters Using
Specify which of the parameters below will be used to specify the treatment group hazard rate and the noninferiority margin by checking the appropriate button.
Differences
Enter the values of D and Δ. The value of h2 is determined from D.
Ratios
Enter the values of HR and m. The value of h2 is determined from HR and the value of δ is determined from m.
Rates
Enter the values of h2 and Δ.
D (Difference, h2-h1)
Specify one or more values of the difference in hazard rates, h2 – h1. This value is used with h1 to calculate the
value of h2 using the formula h2 = h1 + D.
Range
0 ≤ |D| < Δ
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Δ (Non-Inferiority Margin)
Enter one or more values of equivalence margin, Δ. This is the smallest margin above or below h1 that h2 can be
that still results in the conclusion of equivalence. When the null hypothesis is rejected, the conclusion is h1 - Δ <
h2 < h1 + Δ.
Range
0<Δ
Hazard Rates – h2 (Hazard Rate of Treatment Group)
Enter the value(s) for h2, the hazard rate of the treatment group.
Range
h1 - Δ < h2 < h1 + Δ
h1
Enter ‘h1’ when you want to automatically set h2 = h1.
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Example 1 – Finding the Sample Size
Suppose the hazard rate when using the current treatment of a disease is 2. A company wants to show that the
hazard rate of their new treatment is equivalent to the current treatment in that the hazard rate is within a small
margin of that of the current treatment. They want to look at value of δ between 0.2 and 0.6.
How large of a sample is needed if the recruitment period is two-years after which the study continues for an
additional two-years? It is assumed that patients will enter the study uniformly over the recruitment period. The
researcher estimates the loss-to-follow rate to be 0.165 in both the current and the treatment groups. The company
would like to compare sample sizes when the power is 0.90, D is 0, and the significance level is 0.05.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Equivalence Tests for the Difference of Two Hazard Rates Assuming an Exponential
Model procedure window by expanding Survival, then Two Survival Curves, then clicking Equivalence, and
then clicking on Equivalence Tests for the Difference of Two Hazard Rates Assuming an Exponential
Model. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu
and choosing Open Example Template.
Option Value
Design Tab
Solve For ............................................................. Sample Size
Power ................................................................... 0.90
Alpha .................................................................... 0.05
Group Allocation .................................................. Equal (N1 = N2)
ω1 (Loss Hazard Rate of Control Group) ............ 0.165
ω2 (Loss Hazard Rate of Treatment Group) ....... ω1
R (Accrual, or Recruitment, Time) ....................... 2
Percent of R Until 50% are Accrued .................... 50
T-R (Follow-Up Time) .......................................... 2
h1 (Hazard Rate of Control Group) ..................... 2
Specify Hazard Parameters Using ...................... Differences
D (Difference, h2-h1) ........................................... 0
Δ (Equivalence Margin) ....................................... 0.2 to 0.6 by 0.1
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Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results with Ha: |h2 - h1| < δ and Uniform Accrual
Control
Hazard
Rate
h1
2.000
2.000
2.000
2.000
2.000

Hazard
Rate
Diff
h2-h1
D
0.000
0.000
0.000
0.000
0.000

Prop'n
Trtmnt Control
Events
N1/N
E2
P1
2165.3
0.500
962.5
0.500
541.6
0.500
347.2
0.500
241.3
0.500

Trtmnt
Hazard
Rate
h2
2.000
2.000
2.000
2.000
2.000

Total Control Trtmnt
Sample Sample Sample
Size
Size
Size
Power
N
N1
N2
0.9001 4701
2350
2351
0.9000 2089
1044
1045
0.9003 1176
588
588
0.9004
753
376
377
0.9005
523
261
262

Equiv
Margin
Δ
0.200
0.300
0.400
0.500
0.600

Control
Loss
Hazard
Rate
ω1
0.165
0.165
0.165
0.165
0.165

Trtmnt
Loss
Follow
Hazard Accrual
Up
Rate
Time
Time
ω2
R
T-R
0.165
2.0
2.0
0.165
2.0
2.0
0.165
2.0
2.0
0.165
2.0
2.0
0.165
2.0
2.0

Hazard
Ratio
h2/h1
HR
1.000
1.000
1.000
1.000
1.000

Relative
Equiv
Margin
m
0.100
0.150
0.200
0.250
0.300

Var'nce
of
h1 hat
σ²(h1)
4.343
4.343
4.343
4.343
4.343

Alpha
0.05
0.05
0.05
0.05
0.05

Rpt
Row
1
2
3
4
5

Second Section of Numeric Report

Beta
0.0999
0.1000
0.0997
0.0996
0.0995

Total Control
Events Events
E
E1
4329.7 2164.4
1924.0
961.5
1083.1
541.6
693.5
346.3
481.7
240.4

Var'nce
of
h2 hat
σ²(h2)
4.343
4.343
4.343
4.343
4.343

Rpt
Row
1
2
3
4
5

References
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Lachin, John M. and Foulkes, Mary A. 1986. 'Evaluation of Sample Size and Power for Analyses of Survival with Allowance for Nonuniform Patient Entry,
Losses to Follow-up, Noncompliance, and Stratification', Biometrics, Volume 42, September, pages 507-516.
Report Definitions
Power is the probability of rejecting a false null hypothesis. Power should be close to one.
N is the total sample size.
N1 and N2 are the sample sizes of the control and treatment groups.
h1 and h2 are the hazard rates in the control and treatment groups.
D is the difference in hazard rates: h2-h1.
HR is the hazard ratio: h2/h1.
Δ is the equivalence margin.
m is the relative equivalence margin.
ω1 and ω2 are the rates at which subjects in groups 1 and 2 are lost to follow up.
R is the accrual (recruitment) time.
T-R is the follow-up time. Hence, T is the total time of the study.
Alpha is the probability of a type one error: rejecting a true null hypothesis.
Beta is the probability of a type two error: failing to reject a false null hypothesis.
E1 and E2 are the number of events required in the control and treatment groups.
P1 is N1/N, the proportion of the total sample that is in the control group, group 1.
σ²(h1) and σ²(h2) are the variances of the estimates of h1 and h2.
Rpt Row is a line number assigned to allow corresponding report lines to be identified.
Summary Statements
An equivalence test of the difference between hazard rates with an overall sample size of 4701
subjects (of which 2350 are in the control group and 2351 are in the treatment group) achieves
90% power at a 0.05 significance level to detect equivalence when the actual difference in
hazard rates is 0.000 (2.000 in the treatment group minus 2.000 in the control group). The
equivalence margin is 0.200. Patients enter the study during an accrual period of 2.0 time
periods. 50% of the enrollment is complete when 50.00% of the accrual time has past. A
follow-up period of 2.0 time periods has a 0.165 loss to follow-up rate in the control group
and a 0.165 loss to follow-up rate in the treatment group. These results assume that the data
are approximately exponentially distributed.

These reports show the values of each of the parameters, one scenario per row. The second report presents
information about the number of events that are necessary.
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Plots Section

This plot shows the relationship between power and sample size.
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Example 2 – Validation using Chow et al.
Chow et al. (2008) page 173 present an example of a two-group, equal sample allocation equivalence design to
compare the hazard rates of a new treatment with that of the current treatment. The sample size is to be large
enough to detect equivalence when h1 = 1, h2 = 1, and Δ = 0.5. A 3-year study is contemplated with a 1-year,
uniform accrual. There is no loss-to-follow up. Alpha is set to 0.05 and power is 0.80. Chow et al. (2008) carried
out their calculations to only two decimal places. Their results were

 1.64 + 1.28 
N 1= 
 (0.97 + 0.97 )
 0.5 − 0 
≈ 67
2

Note that the variance value should be 1.094, not 0.97. If this substitution is made, the per group sample size is
approximately 75.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Equivalence Tests for the Difference of Two Hazard Rates Assuming an Exponential
Model procedure window by expanding Survival, then Two Survival Curves, then clicking Equivalence, and
then clicking on Equivalence Tests for the Difference of Two Hazard Rates Assuming an Exponential
Model. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu
and choosing Open Example Template.
Option

Value

Design Tab
Solve For ............................................................. Sample Size
Power ................................................................... 0.80
Alpha .................................................................... 0.05
Group Allocation .................................................. Equal (N1 = N2)
ω1 (Loss Hazard Rate of Control Group) ............ 0
ω2 (Loss Hazard Rate of Treatment Group) ....... ω1
R (Accrual, or Recruitment, Time) ....................... 1
Percent of R Until 50% are Accrued .................... 50
T-R (Follow-Up Time) .......................................... 2
h1 (Hazard Rate of Control Group) ..................... 1
Specify Hazard Parameters Using ...................... Differences
D (Difference, h2-h1) ........................................... 0
Δ (Equivalence Margin) ....................................... 0.5
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Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results with Ha: |h2 - h1| < δ and Uniform Accrual
Total Control Trtmnt
Sample Sample Sample
Size
Size
Size
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N
N1
N2
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150
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75
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Rate
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Diff
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0.000
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0.500
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Rate
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1.000

Equiv
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Δ
0.500

Control
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ω1
0.000

Trtmnt
Loss
Follow
Hazard Accrual
Up
Rate
Time
Time
ω2
R
T-R
0.000
1.0
2.0

Hazard
Ratio
h2/h1
HR
1.000
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Equiv
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m
0.500

Var'nce
of
h1 hat
σ²(h1)
1.094

Alpha
0.05

Second Section of Numeric Report

Total Control
Events Events
Beta
E
E1
0.1995 137.2
68.6

Trtmnt
Events
E2
68.6

Var'nce
of
h2 hat
σ²(h2)
1.094

The value of N1 = 75 is close to Chow’s hand calculated 67 and exactly the same as that shown above when the
correct variance of 1.094 is used.
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